FOUNDATIONS of
DIGITAL ART and DESIGN

with ADOBE® CREATIVE CLOUD

xtine burrough
FOUNDATIONS of DIGITAL ART and DESIGN

with ADOBE® CREATIVELY CLOUD

xtine burrough
ACKNOWLEDGEMENTS

It has been an absolute pleasure to work with Michael Nolan (again!) and his team at Peachpit. Margaret Anderson probably read this manuscript more times than I did. Thank you to Gretchen Dykstra, Mimi Heft, Becky Winter, Danielle Foster, Jackie Hill, Jack Lewis, and Glenn Bisignani.

I am grateful for my supportive colleagues in the Department of Communications at California State University, Fullerton. A special thank you must be expressed toward those students who used this book in draft format as we worked the kinks out of exercises that appear in each chapter. Savannah Leigh Steele reviewed nearly all of the exercises and was a lifesaver during the writing process.

Thank you, always, to Christopher James at The Art Institute of Boston at Lesley University for showing me what a passion for photography and visual communication looks like.

This book includes a lot of images of works of art that could easily result in a great amount of permissions expenses. Nearly all of the images in the text were donated. (I paid a grand total of $50 in image permissions for the entire book.) Dear artist and designer contributors, I am forever grateful for your willingness to have your works printed without the fees that often accompany image permissions.

Finally, I have much gratitude for the ongoing support that my friends and family provide: Emily Erickson, Laurie Cella, Lucy HG Solomon, Crystal Adams, Lauren Thompson, Sasha Papovich, Henry Puente, and, of course, mom and dad. Paul Lester, you continue to teach me with an open mind and an open heart. Thank you.
CONTENTS

Introduction IX

SECTION 1:
BITES, PIXEES, VEeCTORS, AND DESIGN

Paths and Vector Graphics 10
Exercises
1. File Presets in Illustrator 11
2. Shapes, Fills, and Strokes 12
3. Figure and Ground with Repeated Dots 15
   Screencast 1-1: The Pattern Brush 17
4. Grouping and Alignment 17
5. A Figure and Ground or “On” and “Off” Study 20
Lab Challenge 20

CHAPTER 2: DRAWING EXPRESSIVE LINES ➤ 21
Saving and Sharing Files 25
Exercises
1. Place and Lock an Image 27
2. Understand Layers 29
3. Create Lines with the Pencil Tool 29
4. Duplicate the Composition 31
5. Add a Gradient Background 33
6. Create Depth with Contrasting Values 35
   Screencast 2-1: Add the “Swoosh” at the Horizon 36
7. Use Master Files and Shared Files 36
Lab Challenge 38

CHAPTER 3: MODIFY BASIC SHAPES ➤ 39
Signs and Logos 42
Vector Curves 43
Exercises
1. Create a Document with One Artboard 43
2. Create Two Basic Shape Combinations 46
3. Duplicate the Artboard and Unite the Paths 47
4. Duplicate the Artboard and Modify the Shapes 48
   Screencast 3-1: Modify Paths with the Pen and Direct Selection Tools 50
5. Reflect and Copy a Second Half onto the Profile Icon 51
6. Brush Details into the Treetop 53
7. Add a Background Color and Save a Multipage PDF 55
Lab Challenge 57
SECTION 2:
DIGITAL PHOTOGRAPHY

CHAPTER 4: CREATING AND ORGANIZING DIGITAL PHOTOGRAPHS • 63
Measuring Light 66
Rule of Thirds 66
Adobe Bridge 67
Exercises
1. Camera Mechanics 69
2. Camera Settings 70
3. Bracketing 75
4. Before You Shoot 76
5. Rule of Thirds 77
6. Bridge Workspaces 80
7. Batch Rename 82
   Screencast 4-1: Renaming and Ranking Files in Bridge 84
8. Generate a PDF to Showcase Your Files 85
Lab Challenge 88

CHAPTER 5: RESOLUTION AND VALUE • 89
Redistributing and Resampling Pixels via Resolution 90
Value and the Tonal Range 91
Zone System Redux 93
Exercises
1. Redistribute Pixels for Print Resolution 95
2. Resample Pixels for Screen Resolution 96
3. Analyze a Photograph Using the Zone System 98
   Screencast 5-1: Use the Info Panel to Check Your Eye Against Image Data 103
4. Modify the Tonal Range with a Levels Adjustment Layer 103
Lab Challenge 106

CHAPTER 6: COLOR MODELS • 107
Subtractive Processes 108
Additive Processes 109
Exercises
1. Harmony in Rectangles 114
2. Simultaneous Contrast in Circles 118
3. Color Comparison 120
4. Color Correction 122
   Screencast 6-1: Applying Color to a Black-and-White Photograph 125
Lab Challenge 125
SECTION 3: DIGITAL MANIPULATION AND FREE FAIR USE

CHAPTER 7: REPAIRS AND HOAXES  ➤  135
Digital Repairs  136
Creating a Hoax  137
Exercises
1. Remove Dust and Heal JFK’s Blemishes  139
2. JFK’s Eyes: Tonal Repairs with Dodge and Burn  143
   Screencast 7-1: Adding and Deleting within Selections  144
3. Reducing Wrinkles  146
4. It’s a Hoax! Adding an Extra Mummy Finger  147
5. Softening Cloned Edges  150
Lab Challenge  152

CHAPTER 8: SELECT, COPY, PASTE, COLLAGE  ➤  153
Precision Selecting with the Pen Tool  154
Nondestructive Editing  156
Exercises
1. Set Up the Collage Workspace  158
2. Trace an Image Contour with the Pen Tool  160
   Screencast 8-1: Tracing with the Pen Tool  161
3. Modify Paths  164
4. Convert a Path to a Selection to a Layer Mask  167
5. Scale, Adjust, and Organize  170
6. Copy a Layer to an Open Document  172
7. The Magic Wand  173
8. Select, Copy, Paste, Repeat  176
   Screencast 8-2: Duplicate, Transform, Burn, Organize, and Adjust—Ants in the Hand  178
Lab Challenge  178

CHAPTER 9: BLENDED REALITIES  ➤  179
Blended Realities in Networked Spaces  180
Screen Resolution  183
Vector Shapes in Photoshop  183
Applying Gradients to Layer Masks  184
Exercises
1. Articulate the Design Challenge  186
2. Combine Vector Shapes in Photoshop  187
3. Layer Effects  190
4. Add a Vector Mask  192
5. Create a Button  193
6. Complete Layer Groups for Steps 2 and 3  195
   Screencast 9-1: Creating Layer Groups  195
7. Gradients and Layer Masks  197
Lab Challenge  199
SECTION 4: TYPOGRAPHY

CHAPTER 10: TYPE AND IMAGE  »  209
Contrast and Rhythm  210
Text Boxes  213
Text Adjustments: Kerning and Leading  213
Exercises
  1. Define a Color Mode  216
  2. Place and Relink an Image  217
  3. Add a Text Box  218
  4. Resize and Kern Display Type  220
  5. Replace Type with an Image  225
  6. Add Vector Shapes to Frame the Composition  227
  7. Final Design Adjustments  229
Screencast 10-1: Hiding Page Elements with a White Shape or a Clipping Mask  231
Lab Challenge  232

CHAPTER 11: THE GRID  »  233
Gestalt  234
Swiss International Style  236
Sentences and Paragraphs  237
Exercises
  1. Alternative Paper Sizes  242
  2. Guides and the Grid  242
  3. Create Your Own “Virtual Leading” Placeholders  244
  4. Linking Text Boxes  246
  5. Placing Another Guide on the Grid  250
Screencast 11-1: Using the Grid  251
  6. Use the Grid  252
  7. Save a PDF with Trim Marks  253
Lab Challenge  254

CHAPTER 12: CONTINUITY  »  255
The Gestalt Laws of Similarity and Continuity  256
Master Pages  259
Paragraph Styles  259
Reading on the Screen  259
Exercises
  1. Create a New InDesign Document for Sharing on the Web  261
  2. Establish Guides on A-Master  262
  3. Place Images  266
  4. Add Text Frames  270
  5. Paragraph Styles  271
  6. Color and a Drop Shadow on A-Master  275
Screencast 12-1: Preparing Files for Placement in InDesign—Relinking Images and Out-of-Gamut Colors  275
  7. Final Adjustments and Export to PDF  276
Lab Challenge  278
I teach in a university communications department. Most of my students have little time in their schedules for classes that would heighten their understanding of visual communication: foundations of two-dimensional design, typography, drawing, and so on. Instead, they enroll in a survey course, Visual Communication, which seats more than 200. Some of them sign up for an elective “skills” course to learn how to use the Adobe Creative Suite (or at least part of it). Obviously, mastery doesn’t happen in a single course. At best, the skills course creates awareness of the concepts and techniques that someone entering the creative professional industries should master. (Of course, I advise students to follow up with related coursework to deepen their knowledge of the craft.)

First developed to serve these students, this book is now used by readers and educators in two-year and four-year fine arts and applied arts programs, college-level communications and media departments, and U.S. high schools. With all of this in mind, the aim of this book is to offer the most information at the confluence of media design (principles, histories, and theories) and software (namely, Adobe) for a wide variety of readers, educators, and practitioners. My goal is to be thorough enough for university students and clear enough for high school students.

The majority of my students are interested in practicing the exercises and mastering the software, because they’re anxious to jump in and create. However, the majority of educators I know are interested in teaching art and design, because they’re passionate not about software, but about media art or graphic design, digital video, and so on.

My approach to mediating this clash of interests is to write (or lecture) about and show as many ideas and examples of art and design history and principles as I can while demonstrating the use of the tools. For example, instead of showing students how to remove red-eye from a photograph (there are loads of videos on YouTube for such a specific endeavor), I demonstrate making a conscious design choice in regard to scale, proximity, the rule of thirds, or other principles while using the same tools. I’ve tried to keep the exercises short, while also showing the fundamental tools in many of the Adobe programs. Most of the tools have changed very little since the first time I used Photoshop in 1992 (with the major exception of the development of layers in 1994, but I digress).
Since my students don’t typically take a course in two-dimensional design, I start in Section 1, *Bits, Pixels, Vectors, and Design*, with material that’s been presented by the authors and artists on whose shoulders I’m crouching: Donis A. Dondis (*A Primer of Visual Literacy*), Johannes Itten (*Design and Form: The Basic Course at the Bauhaus and Later*), David A. Lauer and Stephen Pentak (*Design Basics*), Wucius Wong (*Principles of Form and Design*), and others. It is this understanding of the language of design that I consider foundational. I also include examples of each principle or basic element drawn from contemporary works of digital art. While this book may be assigned in a graphic design program, it’s often read within the broader context of digital art. Though I’m an education advisor on the AIGA Orange County board, my personal identity as a digital artist is also part of this equation.

Two-dimensional design is followed by Section 2, *Digital Photography*. In the classroom, I find it easier to present basic vector graphics before introducing the pixel-loaded arena of digital imaging—Illustrator is often a much more forgiving application than Photoshop due to the insignificance at such a basic level of file resolution. In this text, photography is primarily considered to be another vehicle through which the basic elements of design can be understood.

Since photo manipulation is nearly as old as the medium itself, the natural follow-up to photography is Section 3, *Digital Manipulation and Fair Use*—where better to talk about contrast through juxtaposition?

Section 4, *Typography*, teaches students to honor and manipulate type. This is essential, as most visual communication comprises type and image, and occasionally time. I studied photography in my undergraduate days at the Art Institute of Boston; typography is an art that I learned during my professional life as a web designer in the 1990s and since then as an instructor. It helped that I lived with one of the best typographic educators in Southern California in the early 2000s. I’ve talked with many educators who are strong in one area—photography, typography, web design, or something else—but feel a deficit in another. As such I provide resources for additional materials throughout the book, both for students and educators who might be using this text in a classroom.

The Coda, at the end of the book, explains the important concept of revision. A student may assume that she has an experiential understanding of design principles after simply following the steps in a software application. Students and readers must remember that reading a book on learning to play the guitar is not the same as mastering the instrument. Practice, and of course revision, is the best way to learn the craft and become more efficient. I’ve included revision stories from artists and design professionals alike.
In addition, you’ll find two bonus sections online or in the electronic version of this book:

Section 5, *The Web*, touches just the tip of the interactive iceberg. I rarely reach this section of the text in my own foundations class, but I’ve received feedback from educators who used my prior coauthored publication (*Digital Foundations*) that the chapters are helpful in a variety of courses. I dropped the Flash chapters because the advent of HTML5 and the lack of support for the Flash player on touchpad devices has cornered the program into more of a niche than fits the foundation-level aim of this text.

Automation is key to working efficiently, so one chapter in Section 6, *Effective Work Habits*, available online is dedicated to it. The other chapter addresses the question, “How do you suggest I make a portfolio I can send someone?” There’s no one perfect answer, as each student has different talents and different needs. But learning pagination in InDesign can help students who want to create their own books—a handy thing for soon-to-be graduates or those applying for internships. Lastly, I would like to offer an update of Dondis’s scale that registers the differences (or similarities) among specific artistic media on a continuum of “fine” and “applied” art in FIGURE I.1. To demonstrate that the Bauhaus “would group any and all of the fine and applied arts on one central point in the continuum” [1], Dondis placed the media of the time grouped around a central point on the horizontal axis (Figure I.1). All forms of visual

message-making are influenced and analyzed by an understanding of the basic elements of design, on the screen, in print, as a hologram, or however else they may come to us on future platforms. Whether you intend to be a web designer, a social media entrepreneur, a digital installation artist, or a digitally inspired printmaker, the design foundations offered in this book—coupled with the exercises in each of the software applications—will help you achieve your goals.

Since all students or readers will have different hardware, software, and needs, you’ll learn to use this book in the most fitting way for your setup in the following exercises.

**EXERCISE 1 OPERATING SYSTEMS**

When the Mac was released in 1984, it included a graphical user interface and a mouse, two visual user-oriented components that were missing from other personal computers (Figure 1.2). Artists and designers developed a strong loyalty to Apple over time as their needs and concerns were often met first on the Apple platform. For a while, there was no question about which platform was best suited to making art on the computer: Mac. Universities now have Mac labs dedicated to art and design programs. And in these industries, Mac is still the standard platform. However, multimedia and web designers often work on Windows machines because they need to see what their work will look like in the environment common to most of their users.

Today, it really doesn’t matter if you use a Mac or a PC. Your files will transfer easily from one machine to the other. (Be sure to include the file extensions in the name of your file—something you’ll learn more about in Chapter 1, *The Dot, the Path, and the Pixel*). If you’re creating multimedia art or designs, you’ll want to view the work on both platforms. However, this should not dictate where you conceive and develop the project.

Since most schools, colleges, and universities offer digital art and design classes on the Mac platform, I’ve written this book for the Mac operating system. The screenshots were made on my MacBook Pro. If you’re using a PC, you’ll simply need to translate the following keys as you follow the exercises in this book:

- On a PC, the Control key is used where the Command key (⌘) is indicated for Mac users.
- On a PC, the Alt key is used where the Option key is indicated for Mac users.

That’s it. The rest is more or less the same.

**Figure 1.2** The first Mac computer sold commercially in 1984. It included a mouse and a graphical user interface instead of the ever-intimidating command line.
Some of the exercises in this book will require you to download a work file or a set of files before you begin. All of the files are on the companion website I’ve created for readers of Foundations of Digital Art and Design, www.digitalart-design.com (FIGURE I.3). I’ve also posted a link to the work files on my personal website (www.missconceptions.net), and there’s a Facebook page for Foundations of Digital Art and Design where I’ll post updates and answer reader questions (www.facebook.com/FoundationsOfDigitalArtAndDesign).

Many of the images in this book were donated by artists and designers. Some were available for me to use in a commercial publication because the copyright had expired, or because the work was part of a government archive, which usually puts it into the public domain, or because the artist(s) who created the work used a Creative Commons (CC) license in lieu of a traditional copyright. To those who donated or published with CC licenses: thank you!

You’ll learn more about the copyleft movement and creative licensing techniques in the introduction to Section 3, Digital Manipulation and Free Fair Use.
Leo Villareal often incorporates LEDs, custom circuitry, and a microcontroller in his light installations (http://youtu.be/Jxjhki-s3V8).
Creating and Organizing Digital Photographs

The exercises in this chapter will explain the camera mechanics involved in creating a photograph and demonstrate how to organize, rename, and set up a digital “contact sheet” via a PDF of your images. You’ll explore your camera and use your files or those from the companion website to learn some of the best file management tools available in Adobe Bridge.

Light is essential for creating a photographic image. How the light is measured and captured in the camera will affect the resulting image. In this chapter, you’ll learn to control how much light is rendered in your “light drawing” or photograph. In the following chapters, you’ll learn to compose within the frame of the viewfinder and to adjust the tonal range during the post-production process. Since outdoor light is a direct product of the sun and moon, the amount of natural light in a photograph also relates to the time of day. Conceptually, time, considered as both duration and as the shift in lighting as day passes to night is a rich theme for photographers and artists to explore and interpret. The new media artist duo Jon Thomson and Alison Craighead...
(known simply as Thomson and Craighead) created an installation titled *Horizon* that displays a representation of the time at one specific location—the horizon (FIGURES 4.1 AND 4.2). On their website, they write:

Horizon is a narrative clock made out of images accessed in real time from webcams found in every time zone around the world. The result is a constantly updating array of images that read like a series of movie storyboards, but also as an idiosyncratic global electronic sundial [1].
Your camera may offer you anything from no control over the way light is registered on the digital sensor (which is ultimately responsible for the resulting image file) to complete control in manual mode. Some of the information in the Camera Mechanics exercise won’t apply to your situation if you’re using a point-and-shoot camera or a mobile device. However, most of my students have access to consumer- or prosumer-level (not quite professional but a step above the consumer level) digital cameras and many have digital single lens reflex (DSLR) cameras. This range offers the photographer some degree of or even full control.

Photography began as a technical and scientific pursuit of creative and documentary expression. The pervasive nature of digital cameras makes it difficult for some people to conceive of the craft as specialized. For many, the camera is just another gadget. Harrod Blank’s Camera Van (FIGURE 4.3) includes one of every Polaroid camera ever made along its front grill, and that’s just the beginning. The word “SMILE” is printed across the top of the van, each letter formed of Kodak Instamatic cameras (FIGURE 4.4). On the driver’s side, a cameramural of the Kodak Instamatic is made of mounted Instamatics. Do they work? Yes, they do! Screens display photos taken with the van (FIGURE 4.5).

Blank showcases image galleries for each set of audiences he’s driven past in Camera Van (FIGURE 4.6). After learning of the many ways to control the production of a single photographic image, even skeptics should agree that the craft is as rich and complicated today as it was in the days of glass negatives.
MEASURING LIGHT

The amount of light required to make a photograph is measured with a meter. In the predigital era, some SLR cameras had built-in light meters, while large-format cameras did not. External light meters are still used today in photography studios. Digital cameras include a built-in light meter. The light meter registers the amount of light that’s either in the center of the frame, averaged throughout the frame, or—for some cameras with the “spot” option—at a specific location within the frame. Understanding how to adjust your camera settings to comply with the light meter specifications requires you to understand the role of the f-stop and shutter speed camera controls. The light meter reading will show you how much light will be required to make a legible exposure for a balanced combination of f-stop and shutter speed settings discussed in Exercise 1. Generally, the purpose of your exposure will be to present photographic details at the extreme areas of contrast in the image. That means you’ll want to capture details in the highlights and details in the shadows.

If you’re shooting in automatic mode or can’t control these settings, you’ll simply point and shoot, and then hope for the best. Be careful when composing images in high-contrast lighting situations. Avoid shooting at or near noon, when the sun and shadows are strongest. And avoid low-light situations.

If you’re working in manual mode, once you know how much light you need, balance the f-stop (which governs the diameter of the aperture) and shutter speed (which controls the duration of the shutter release) settings. Your choices about these two settings will depend on the depth of field (in the case of aperture) and movement (shutter speed) you want to include.

Some cameras let you create photographs in “aperture priority” or “shutter speed priority” modes. This means you can choose which of those two features you want to control. The camera will set the opposing lighting variable according to the choice you make.

RULE OF THIRDS

In addition to your camera setting choices, you’ll be making decisions while creating a composition. As you can imagine, there are a lot of technical and aesthetic choices to make while creating powerful photographic imagery. In Exercise 5, you’ll learn to see the compositional space using crop guides that make visible the “rule of thirds.” This is a common way to understand the photographic frame, which is most often a two-dimensional environment with a 3:2 ratio. (4:3 and 16:9 are also common ratios among a variety of digital
media.) The premise of the rule of thirds is to evenly divide the frame by two horizontal and two vertical lines before composing the subject matter along the intersections of those guides (FIGURE 4.7).

One desired result of the rule of thirds is the elimination of the number one newbie mistake: centering the subject in the middle of the frame. You’ll also start to see and weigh the visual balance of your subject matter by thirds, bringing more tension and energy to the overall composition. The more you’re aware of the compositional space, the more likely you’ll be to create a composition that leads the eye to your desired focal point.

GET CLOSER AND WATCH THE EDGES

Two additional pieces of advice that I give to new students are not specified by the rule of thirds:

- Get closer. By that I mean physically move your body and your camera closer to your subject.
- Watch the edges of the frame. The viewer shouldn’t be left in no-man’s-land at the edges of the frame. Be conscious about using the full frame to tell your visual story.

FIGURE 4.7 An image composed adhering to the rule of thirds.

RATIOS

A ratio is a relationship between pairs of numbers. For instance, if you’re cooking rice at a 1:2 ratio with water, you’ll add one part of rice to the pot for every two parts of water. Instead of instructing someone to cook one cup of rice with two cups of water, it’s more scalable to advise the ratio.

ADOBE BRIDGE

Admittedly, when Bridge was first released for Adobe Creative Suite 2, it was, how shall I put this, not terribly user-friendly. I didn’t use it. My students didn’t use it. No one I knew used it. We might have tried it a few times, but it just didn’t seem worth the effort. After several revisions, Bridge has become an organizational tool that is absolutely worth learning. Bridge was primarily developed to allow you to organize and view file information relating to all the various types of files you generate using Creative Cloud.
WHAT YOU’LL NEED

Download the following source materials to complete the exercises in this chapter:

✔✔ The chapter4-start folder from the Chapter 4 downloads area on the book’s companion website includes a rule-of-thirds folder and a batch-rename folder for those exercises.

You’ll begin the exercises in this chapter by exploring your digital camera.

WHAT YOU’LL MAKE

In the exercises for this chapter, you’ll organize your digital photographs in Bridge and create a PDF that showcases a series of images (Figure 4.8). This serves the same purpose as and looks similar to the contact sheets that photographers have used for decades. Your PDF will contain images, and it will display your file naming system.

FIGURE 4.8 Completed PDF contact sheet created in Chapter 4 exercises.
In the following exercises, you’ll learn how to rename a folder of files, label (or rate) your files, and generate a contact sheet in a PDF, all at the click of a button. In Chapter 16, Automation, you’ll use Bridge to apply Photoshop actions.

**ExerCise 1: Camera Mechanics**

Basic operations take place when you create a photograph with your digital camera. There may be many adjustments to the camera that you can make, if your camera gives you control over them. These will have a direct result on the aesthetics of the resulting photograph. Most cameras also have an automatic setting, which lets you simply point and shoot. Even if you’re just pressing the button, each of the following steps will take place. Details about each step are included in Exercise 2.

- Before shooting, consider adjusting the white balance, ISO, and file size settings. Or, just let the camera do that work for you. (Your camera might not allow you to control some of these settings.)
- Frame a scene by placing your eye to the viewfinder or by peering at the LCD screen on the back of the camera. Many DSLRs don’t allow use of the LCD during shooting. If you have both options, consider the pros and cons of each (TABLE 4.1).
- After the image is framed, decide whether to shoot in automatic or manual mode. Do you want the camera to control the amount of light on the sensor, or do you want to control it by balancing the relationship between the f-stop (the diameter of the aperture) and the shutter speed (the quickness of the shutter release)? You’ll learn more about f-stop and shutter speed settings in the next step.
- Press the shutter release button. Hold the camera tightly and try to eliminate body movement.
- The shutter will open, and the aperture will enlarge or decrease according to the f-stop settings.
- Light will be recorded on the digital sensor.
- The shutter will close based on the duration of time indicated by the shutter speed settings.
- You can preview your image immediately as it is saved on a memory card.
The following items are elements you might be able to control when making a photograph. All digital cameras have different user interfaces. I’ve indicated where these items typically appear on the cameras I’ve seen in my classroom. Yours might be different. The best thing to do is read your camera’s manual, or at least view the page containing the illustration of the camera and its settings! Did you lose it (or throw it away with the box)? Most manuals can be downloaded from the manufacturer’s website.

- **File Size, Compression, and/or File Format.** These typically appear in the camera menu or function area.

  Even if your camera isn’t terribly fancy, you may have a choice of creating small, medium, or large images, or you might even have a specific set of resolutions, via pixel dimensions or megabytes, to choose from in the File or Camera menu.

  You also might be able to choose to shoot in JPG, TIFF, or even RAW mode. Shooting in RAW mode yields the most information and adaptability, but processing a RAW image is outside the scope of this book. (There are plenty of books that deal specifically with Camera RAW, and I encourage photography students to become familiar with these details.) If you can choose between shooting in JPG or TIFF modes, you should know that the JPG will be more compressed (and usually a smaller file size) than the TIFF.

### LCD VERSUS VIEWFINDER: WHERE SHOULD YOU LOOK WHILE FRAMING A PHOTOGRAPH?

This choice is dictated by personal preference and limitations presented by the type of camera you’re using. When using my DSLR, I always use the viewfinder. However, on my iPhone, I’m forced to use the LCD.

<table>
<thead>
<tr>
<th>LCD</th>
<th>VIEWFINDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accurately represents the framed image space</td>
<td>Can be slightly inaccurate in consumer cameras due to what is called “parallax&quot; as the viewfinder location is slightly above and to the left of the lens</td>
</tr>
<tr>
<td>Can lead to instability: since you’ll hold the camera away from your face to see through the viewfinder, the camera is less stable than it would be if you were holding it closer to your balanced body.</td>
<td>Often leads to greater stability: you’ll hold the camera to your face while making the photograph. Remember to square your hips and be still while you shoot.</td>
</tr>
<tr>
<td>Drains battery power</td>
<td>No extra battery power is required for composing through the viewfinder.</td>
</tr>
</tbody>
</table>

**TABLE 4.1**
• **ISO.** ISO typically appears in the Camera or Function menu. The ISO rating is analogous to what was once referred to as the *film speed.* Silver nitrate is the light-sensitive chemical found in film. The amount of silver in the film stock directly correlates to its ISO rating.

• **Low ISO.** A low ISO rating (25 or 50 in special films, 100 or 200 in the kind of film you can purchase at the drug store) indicates that there’s little silver nitrate in the film. This in turn means that you’ll need a lot of light in order to register the image on the film. If you’re shooting outside on a bright day, set the ISO to a low setting. What’s the advantage of using a super low ISO setting? In the film world, you’ll see less film grain in the resulting print. In the digital world, the same rule applies—though we’ll just call the film grain “digital noise.” If you’re shooting in a studio and you want to create a high-quality print devoid of noise, use the lowest ISO your camera offers and set up plenty of lights.

• **High ISO.** A high ISO rating (800, 1600, 3200 in special films, 400 in common film stocks) indicates that there’s a large quantity of silver nitrate in the film. This in turn means that you’ll need little light in order to register the image on the film. If you’re shooting indoors, in the late evening, or at night, you’ll probably need to set the ISO to a high setting. The advantages of using a high ISO setting are that you have greater flexibility in low-light situations. However, you’ll see the grain of the film or some digital noise in your files (FIGURE 4.9).

*FIGURE 4.9* Although high ISO settings make it possible to create images in low light, they often result in digital noise. Photograph by Thomas Van Deusen.
• **White Balance.** Along with ISO, this typically appears in the camera or function menu.

Setting the white balance on your camera, if you’re able, will ensure that the whites appear as a true white, and that the rest of the colors in the spectrum of the photographs are not the victims of a nasty “color cast” (FIGURE 4.10).

The following are typical (self-evident) setting labels or icons you might find in a menu or function area. Match the white balance lighting to your situation: Auto (A-WB), Daylight (sunshine icon), Cloudy (cloud icon), Tungsten (lightbulb icon), and Night (moon or flash icon).

• **Aperture.** If you can control the aperture, you’ll typically do so with a dial or button near the top of the camera body.

The aperture is the size of the opening that light travels through the lens to the digital sensor. The wider the aperture opens, the more light you’ll send to the digital sensor; of course, the inverse is true, too (FIGURE 4.11). The aperture’s diameter size is controlled by the f-stop. Here’s the tricky part: the smaller the f-stop number, the wider the aperture is open.

![DAYLIGHT SETTING](image)

![TUNGSTEN (OR INCANDESCENT) SETTING](image)

![“SHADY” SETTING](image)

FIGURE 4.10 Three photographs of the same scene made in natural daylight demonstrate the results of different white balance settings. If the white balance setting on the camera does not match the situation, the result may be an unpleasant color cast.

### UNDERSTANDING F-STOP VALUES

The trick is to remember that the f-stop is a ratio, which means that the f-stop number you select on your camera refers to the denominator of a fraction where the numerator is 1. There is an inverse relationship between the size of the number and the size of the aperture opening. A small denominator corresponds to a big ratio (or a wide aperture).

![f-stops](image)

FIGURE 4.11 This illustration demonstrates decreasing aperture sizes. Created by Cbuckley and updated by Dicklyon on Wikipedia.
• **Depth of Field.** When the aperture is wide open (for example, f/2) the resulting image has a small area of focus; a large f-number (for example, f/22) generates a large area of focus in the image. Photographers refer to this optical phenomena as “depth of field.” Shallow depth of field is created with lower f-stop numbers (FIGURE 4.12), while greater depth of field is seen in photographs made with larger f-stop numbers (FIGURE 4.13). Figures 4.12 and 4.13 showcase the results of using lower and higher f-stop values and the types of visual situations where one is preferred to the other.

---

**FIGURE 4.12** Lauren Thompson, Snow White series, 2012. In this image, a low f-stop was used to create shallow depth of field. The focus on the figure's face contrasts with the blurriness of the tree branches she stands behind.

**FIGURE 4.13** Tracey Cole, 2012. In this photograph, a high f-stop is used to capture the details in the glass object.
• **Shutter Speed.** If you can control the shutter speed, you’ll typically do so with a dial or a button near the top of the camera body.
  
  • The shutter speed indicates how quickly (or slowly) the shutter will open and close. In automatic mode with a reasonable amount of light, the shutter will probably release at about 1/60th of a second.

  • Anything above 1/60th of a second (which might just be indicated by the number “60” on your digital camera) is considered somewhat fast. A fast shutter speed will appear to “freeze” time, allowing viewers to see a moment that often escapes us. A cup filled with liquid in midair, for instance, can be recorded before it spills (FIGURE 4.14).

  • A slower shutter speed (1/15th of a second, 1/8th of a second, or more) will result in images that record subject matter movement. In FIGURE 4.15, the musicians and lights are blurred as they move rapidly on the stage.

---

**SHUTTER SPEED AND SHAKY PHOTOGRAPHS**

Your photographs will not display movements due to your physical inability to remain completely still at a shutter speed of 1/60th of a second or less (1/125th of a second, 1/250th of a second, and so on). With practice, you can probably even seem to hold the camera still at 1/30th of a second. Some people claim to be able to get a still image while hand holding the camera at 1/15th of a second (but that has never been the situation for me). If you plan to shoot at a slower shutter speed, use a tripod or steady the camera without human interference.
Exposure Value (EV or E/V). If you can’t control the f-stop or shutter speed, you may be able to alter the exposure value, typically accessed by a button on the back of the camera near the LCD. This button will normally allow you to take a photograph with slightly lighter and darker exposure values. On some cameras, you can press a Plus (+) or Minus (-) button; on others, you just spin a dial to move across a sliding scale. Altering the exposure value is an essential skill to learn so you can bracket your exposures while you’re still learning to create photographs.

**BRACKETING**

Like the rule of thirds (see Exercise 5), bracketing is one of the first lessons new photographers learn. Since you’re drawing with light when you create a photograph, the exposure of light that you set in your camera has one of the biggest visual impacts on the photograph. Bracketing is a method of increasing and decreasing the exposure value on the same scene in order to understand the visual results of an array of exposure values in a particular lighting situation. If you’re new to photography, bracketing in as many lighting situations as you can will help you understand how light will register in the visual image made by your camera.

On any camera where you can control the exposure value, use the bracketing technique by shooting the same scene at least three times (Table 4.2). First, take a photograph using the most accurate exposure value according to your light meter (built in to DSLRs or likely whatever the automatic mode will indicate on consumer cameras). Then create another photograph of the same scene with one stop of additional light (a single shutter speed setting or f-stop setting). Follow this by creating one more photograph of the same scene by decreasing the amount of light to the sensor by one stop (a single shutter speed setting or f-stop setting in the opposite direction), starting from the “center” or original metered reading (Figure 4.16).

![Bracketed photographs](image)

**FIGURE 4.16** Bracketed photographs. If you’re only bracketing with three images, watch out for digital cameras that include half-stops. It’s best to bracket at least five or eight times if you’re brand new to the concept. You’ll learn how your camera operates by experimenting.
Before you take off with your camera for a photography session, set aside an intentional moment where you consider some of the camera settings that may not change throughout your shoot:

- Prepare for the lighting situation: Is it daylight? Is it near evening?
  - Set the ISO for the amount of light you expect to capture.
  - Set the white balance for the type of lighting condition.

### COMMON BRACKETING SETTINGS

<table>
<thead>
<tr>
<th>DSRL</th>
<th>CONSUMER CAMERA</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you can control the f-stop and shutter speed settings, use the following list.</td>
<td>If you simply have the Exposure Value (EV or E/V) button on your camera, use the following list.</td>
</tr>
<tr>
<td><strong>Photo 1</strong></td>
<td>Use the most accurate exposure value according to your light meter. You may need to manually adjust your shutter speed or f-stop value, or both, to achieve a balanced meter reading. Use the most accurate exposure value according to your light meter. You’ll probably see in the Exposure Value (EV or E/V) area of your camera settings that there’s a dotted or dashed line, or perhaps a series of vertical straight lines with an indicator (a dot, usually) of the current exposure value. In automatic mode, the exposure value will likely fall in the center of the line. Pressing the EV button (or spinning a dial) will let you register that dot to the right or left of the center mark, which increases or decreases the exposure value.</td>
</tr>
<tr>
<td><strong>Photo 2</strong></td>
<td>Lighten the exposure value by one f-stop or by one notch on the shutter speed scale. For instance, if Photo 1 was taken at 1/60th of a second, take Photo 2 at 1/30th of a second to lighten the exposure value by one notch down on the shutter speed scale. (The shutter will remain open longer, allowing more light to register on the digital sensor.) Or, if Photo 1 was taken at f/5.6, take Photo 2 at f/4 to increase the amount of light through a wider aperture. Lighten the exposure value by one notch to the right of the center on the exposure value line. You’ll have to figure out how to add and subtract a notch on the EV scale.</td>
</tr>
<tr>
<td><strong>Photo 3</strong></td>
<td>Now decrease the exposure value. Create a photograph that’s darker by one f-stop or one notch on the shutter speed scale. For instance, if Photo 1 was taken at 1/60th of a second, take Photo 3 at 1/125th of a second to darken the exposure value by one notch up on the shutter speed scale. Or, if Photo 1 was taken at f/5.6, take Photo 3 at f/8 to decrease the amount of light through a narrower aperture. Darken the exposure value by one notch to the left of center on the exposure value line.</td>
</tr>
</tbody>
</table>

**TABLE 4.2**
APERTURE PRIORITY OR SHUTTER SPEED PRIORITY?

Many prosumer-level cameras offer the ability to shoot in aperture or shutter speed priority. This is likely to be a setting listed on a dial (A or S). If your goal is to create an image with shallow depth of field, for instance, you might shoot in aperture priority mode and set the f-stop to a low number. The camera would then adjust the shutter speed for you, based on the light meter reading that it detects. Alternatively, perhaps you want to create a “freeze frame” of your friend as she dives from a high platform. You might shoot in shutter speed priority mode and set the shutter speed to a low fraction (maybe 1/125th of a second or 1/250th of a second). In this case, the camera would control the f-stop according to the light meter.

- Where will the photographs be published or printed? Do you need high-resolution images or are these just “practice shots?” Will the photographs be published strictly on a website?
  - Set the image size or resolution. (Use the largest size if you plan to print your images, and a medium or smaller size for experiments or web content.)
  - Set the format of the file. Use RAW only if you know how to process the RAW formatted images. If this is currently beyond your expertise, it may not be worth saving such large image sizes at this point in time.
- If you have the option, do you want to shoot in full manual mode, shutter speed priority, or aperture priority? Set the mode now.

EXERCISE 5  RULE OF THIRDS

As you’ve seen, the rule of thirds is a compositional concept that photographers use while framing the image during its production. Some cameras have a rule-of-thirds grid that you can superimpose in the viewfinder to see the guides while you’re creating the photograph. In this exercise, you’ll see how to use this compositional structure in Photoshop to assist you during post-production editing.

1. Open the file dog-beach.psd from the rule-of-thirds folder.
2. I’ve purposefully selected a lousy composition for you to work with in this exercise. Where are the first and second focal points? What’s happening at the edges of the frame? Notice that the middle dog and the large branch are two main areas of focus. Where are they positioned in the frame? The top of the frame is full of distracting information: the cone, the volleyball net, and the houses in the background are all unnecessary to the activity in the primary focal area. In the next step, you’ll reframe this image.

WORKSPACE > ESSENTIALS

Open Photoshop and set the workspace to Essentials by selecting it from the pull-down list in the Application Frame or by choosing the Window menu > Workspace > Essentials.
3. Choose the Crop tool from the Tools panel and set the tool options to Unconstrained and View: Rule of Thirds (FIGURE 4.17) in the Options panel.

4. Pull the Crop anchor at the middle of the top frame down so the top of the frame touches the tip of the red dog’s tail (FIGURE 4.18).

5. Notice where the rule-of-thirds guides are located on the image. The branch is located precisely in the central square. You’d rather see main elements on one of the vertical or horizontal lines than inside what would be a cell if you think of the grid as a table. Move the crop guide on the left edge of the frame toward the middle of the image until the branch is more or less aligned on the left vertical rule-of-thirds guide (FIGURE 4.19).

6. Let’s eliminate some of the bottom area of the image, just as you did with the top—the information at the bottom is simply distracting the viewer from the activity. Move the bottom crop guide toward the top of the image, keeping the idea of a two-thirds to one-third compositional ratio in mind. I adjusted the bottom crop guide so that the Weimaraner’s front left paw is planted on the top horizontal guide (FIGURE 4.20).

7. You can continue to adjust the crop guides until you’re satisfied with the crop. Notice that while you’re cropping the image, the Layers panel indicates that you’re in a Crop Preview (FIGURE 4.21). Press the Commit Current Crop Operation button in the Options panel when you’re finished (FIGURE 4.22).

Save the file as **dog-beach-cropped.psd** to complete the exercise.

---

**FIGURE 4.17** The rule-of-thirds grid can be viewed by using the Crop tool.

**FIGURE 4.18** Adjust the Crop anchor to eliminate distracting information.
Align the subject on the rule-of-thirds grid. Pay attention to the edges of the photographic frame when cropping the image. The Layers panel will display the layer as Crop Preview while you’re working with the Crop tool. Starting with Photoshop CS6, you have the option to retain or delete cropped pixels. I prefer to retain pixel information, so I leave the Delete Cropped Pixels button unchecked, as seen here. Click the checkmark icon to exit the Crop tool or press the Return key.
BRIDGE WORKSPACES

For the following exercises, you may use the images from your photo shoot or the series of photographs in the batch-rename folder. To demonstrate the following exercises, I used 12 daguerreotype photographs taken by Mathew Brady with the words “unidentified woman” in the title, which I downloaded from the Library of Congress website. Place the files in one easily accessible folder. I copied mine to a chapter04 folder on my desktop.

1. Launch Bridge from the Mac dock or the PC Start menu, as you would open any other application. However, if you're opening Bridge, you probably have a particular set of files in mind that you want to review. An easy way to get into Bridge is to drag and drop the file of folders you want to view directly on the Bridge application icon. This method of opening the application forces a specific set of images to be on view immediately, once Bridge is open. Drag your folder of photographs on the Bridge icon (FIGURE 4.23).

2. To ensure that your screen looks similar to mine, choose the Window menu > Workspace > Essentials.

3. Notice that the content of the folder you dragged on the Bridge icon appears in the main window (the second of three columns) beneath a tab labeled Content. The file path to this content appears on the top left of the application window (FIGURE 4.24).

4. The top of the first column holds a set of tabs for Favorites and Folders. If your folder isn't displaying in the Content area, you can use one of these two tabs to navigate to the folder you want to view. (For instance, if your folder is located on the desktop, you can click the Desktop button from the Favorites list and then double-click the appropriate folder in the Content area.) Locating your files within Bridge is essential because you won't be able to do anything to your files unless you can see them in the Content area.

5. Drag the slider in the lower right of the Content area to enlarge or decrease the thumbnail view of your files (FIGURE 4.25). Since I only have 12 files in my folder, I zoomed out enough to see all of them on the screen at once.
6. The column on the far right contains the Metadata tab. This provides you with the most information about your files. Click once on any of the images in the Content area—be careful not to double-click, as this may open your file in another application! Meta information (or information about the selected file) appears in both the Metadata Placard (FIGURE 4.26) and the File Properties menu. The Metadata Placard is especially helpful if the images were created on a digital camera that stores metadata within the image file. (For instance, digital single lens reflex cameras will store this information.) If the files were downloaded from a website (as mine are), the Metadata Placard won’t show as much information. However, the File Properties menu will enable you to learn about the file’s format (or document type), size, pixel dimensions, color mode, and more (FIGURE 4.27). Quick access to this type of information can be extremely helpful when you have a folder with many similar files.

BE CAREFUL! Double-clicking on a file in Bridge may open that file in a different application, such as Photoshop or Illustrator. You can alter these settings in the Preferences dialog, Command(⌘)-K, by selecting File Type Associations from the list in the left column and choosing an application to open for files in the JPG (or other) format.
The tool I use most in Bridge is Batch Rename. This command lets you assign a new file name to a group of files. You can rename an entire folder of files or just a few files selected within a folder.

1. The file names that I’ve assigned to the 12 photographs are long. I included a number, the source (“loc” for “Library of Congress”), the photographer’s last name, and the name of the series. Let’s assume that you’re going to select half of these original files to modify in your own work. You want a new folder for your work, and you want to rename the files with your first initial, last name, and a sequence number (for example, x-burrough01.jpg). Before running a batch rename, decide on a system for renaming the files. Start by selecting the files you want to use. In this hypothetical situation, I’ll select every other file by holding the Command key as I click on each of them in the Content area (FIGURE 4.28).

2. With the files actively selected (you’ll see an outline around the selected file thumbnails), choose the Tools menu > Batch Rename. In the Batch Rename dialog box, you’ll make several choices as follows.

![FIGURE 4.28](image-url)
3. In the Destination Folder area, press the radio button next to “Copy to other folder” because you are going to create a copy of the original files with a new name. Press the Browse button, locate your `chapter04` folder (or the folder where you’re saving the images in the Content area), press the New Folder button, name the new folder (FIGURE 4.29), and then press the Open button.

4. In the New Filenames area, I pressed the small Minus (-) radio button to the right of several of the Filenames fields (FIGURE 4.30). The original file name was lengthy, and I find it easier to start anew.

5. Change the first Filenames field to Text and then enter the first initial of your name followed by a dash (-) in its field (FIGURE 4.31).

6. Press the Plus (+) radio button to the right of the first Filename field you just set to add more information to the filename.

7. Select the Text option again and enter your last name in the field. Press the Plus button (FIGURE 4.32).

8. Choose the Sequence Number option from the pull-down list. Be sure the numbering starts with “1” and choose Two Digits from the pull-down list to the right of the field (FIGURE 4.33).

**BE CAREFUL!** I usually rename my files in the same folder rather than copy my files to a new folder. However, consider yourself warned. When you rename files in the same folder, you’ll have lost the original names. You can’t undo a batch rename.

You may not need to “clean” your Filenames fields area. You’ll add new fields in the Step 6.
9. Review your selections. You should see the proper file path to the new folder. An example of the new file names appears at the bottom of the dialog box, as well as a message about how many files will be renamed. If all of this seems accurate, press the Rename button.

10. Scroll down in the Content area if you need to and find the new folder you created. Double-click the folder to open its contents. You should see your six renamed files in the Content area (FIGURE 4.34).

**SCREENCAST 4-1 RENAMING AND RANKING FILES IN BRIDGE**

Renaming files in Bridge using the Batch Rename tool is simple, but it comes with a heavy price: there's no going back! Watch a short video demonstrating this process.

All screencasts are available on the companion website, www.digitalart-design.com or on the YouTube playlist, www.youtube.com/playlist?list=PLAy6P5IoEjy2v3kZkCt8spqJ50nLb2XQI.
If you had one or several sheets of negatives to preview, you’d go to the darkroom, press the negatives directly onto a sheet of sensitized photographic paper with heavy glass, and expose the glass-negatives-paper sandwich with the light of an enlarger. The resulting proof is called a contact sheet because of the direct (negative in contact with the paper) printing process. Digital images can be previewed on the camera, so in a sense the need for contact sheets is not terribly urgent. Yet it’s extremely common to share a set of images, mock-ups, or compositions with others in a single file. Earlier versions of Photoshop (before CS4) included an automated process for creating these types of documents, aptly titled Contact Sheet. Starting with CS4, the Contact Sheet automated task was transferred to Bridge. In the following exercise, you’ll create a PDF of thumbnail (or larger)-sized images using Bridge’s Output Workspace.

1. View the contents of your chapter04 folder (my set of 12 images or your own photos) in Bridge. I had to choose the View menu > Show Reject Files to see all 12 images. You may also see the folder you created in Exercise 3.

2. Press ⌘-A to select all the files. Press the Command key while deselecting the folder or any other files you don’t want to include in the PDF (FIGURE 4.35).

---

FIGURE 4.35 To select all the files without selecting the folder press ⌘-A (to select all) and then hold the Command key while clicking once on the folder to deselect it. Click and drag to move the files into the deselected folder.
3. Notice that the selected items appear in the Preview tab in the top-right column.

4. Press the Output button in the top-right area of the application window or choose Window > Workspace > Output (FIGURE 4.36). Notice that the layout of the tabs in Bridge changes. The selected content items are organized in a single row along the bottom of the application. The main area is reserved for the Preview tab. The right column is dedicated to the Output tab and menus beneath it.

5. Starting at the top of the Output tab, make the following selections:
   
   A. Press the PDF button. (It's selected by default.)

   B. In the Document menu, choose a page preset (I selected US Paper), a size (Letter), and set the Quality slider to the resolution of your choice. If you're just sharing files for a screen presentation, you can set the resolution as low as 72 or 96 DPI. I typically ask students to set the quality to 150 DPI so you can zoom in on images without seeing them pixelate during a critique session.

   C. In the Layout area, set the number of columns and rows you want to see. The more columns and rows you choose, the smaller the images will be on the page. I set mine to 2 by 2 and checked the Use Auto-Spacing box.

FIGURE 4.36 Select files in the Output workspace to save them as a PDF.
The Overlays area lets you include a file name with your image. I keep the box next to Filename checked, because I like to see the filename so I can check how my students are naming their files (Figure 4.37). Also, it easily allows you to reference an image by name, rather than by description.

6. Scroll down in the Output area. I don’t often use the Header, Footers, Playback, or Watermark menus, but they’re clearly labeled should you want to add those features to your document. You can collapse the menus you don’t want to use by pressing the sideways arrow to their left (Figure 4.38). Finally, check the View PDF After Save box and then press the Save button.

7. Save the PDF in your chapter04 folder. Open it if it doesn’t open automatically (if you forgot to check the View PDF After Save button, for instance) and preview your files.
8. Check the PDF file size on your operating system. On a Mac, you can see the file size by viewing the files in list format or by clicking on the file once and then choosing File menu > Get Info in the Finder or Desktop area. On a PC, you can right-click the file and view the file size in the Properties area. Since I set the resolution to 150 DPI (which is relatively low), my document showcasing 12 images is less than 4 megabytes—a reasonable size for emailing or uploading the file.

LAB CHALLENGE

Find or take a series of photographs to demonstrate the theme “time passing.” This is a classic photography assignment for which many people have photographed a flower throughout its growth and death stages. Don’t choose to document a flower! What other visual references to the passing of time can you develop? (Stretch your imagination and avoid imagery of clocks, too). Take several shots based on one idea and place them in a single PDF using Bridge.
INDEX

NUMBERS

2pxBorder, 41

A

Adams, Ansel, 61–62, 93, 100
Add Anchor Point tool, for modifying shapes, 49
additive processes, 109–111
Ades, Dawn, 128
adjustment layers
  for hue, saturation, and brightness, 116–117, 171, 177–178
  levels adjustment layer, 103–106, 172
  nondestructive editing and, 156
Adobe Bridge
  Batch Rename tool in, 82–84
  digital photography and, 67
  organizing digital photos, 80–81
  Output workspace, 85–88
Adobe Illustrator
  arranging stacking order of elements, 45
  creating circles, 10
  creating text boxes, 247
  file presets, 11–12
  Pathfinder panel, 188
  typographic treatment with, 208
Adobe InDesign
  creating document for sharing on web, 261
  placing text in text frames, 270–271
  preparing files for placement, 275
  scaling images, 268
  typographic treatment with, 208
Airey, David, 42
Albers, Josef, 112–113
alignment
  Align panel, 19
  of basic shapes, 46–47
  guides and, 264–265
  left, right, centered, justified, 238–239
  of rows of dots, 17–20
  on rule-of-thirds grid, 78–79
  of text boxes, 252
typographic styles and, 273–274
alpha channels, 184. See also layer masks
analog, combining with digital techniques, 285
anchor points
  creating shapes, 44
  defining circle edges, 14
  modifying paths, 165–167
  modifying shapes, 48–50
  moving, 232
  Pen tool and, 154
  tracing an image with Pen tool, 162–164
  in vector graphics, 10, 43
aperture priority, 66, 77
aperture size, 72
appropriation practice, 133
apps, screen resolution for, 183
Arnheim, Rudolf, 39
artboard
  Artboard tool, 232
  creating shapes on, 43–45
  duplicating, 47–50
  features of, 12
artists/designers, communication with clients, 281
ascenders, of a letter, 203
Atkins, Anna, 128
augmented reality, 182
Azzarella, Josh, 137
B
background
  adding color to, 55–57
  creating background layers, 136, 140
  with repeated dots, 15–17
  shifting nature of, 7–8
backward compatibility, 37
Barthes, Roland, 42
baseline, of a letter, 203
Batch Rename tool, 82–84
Bauhaus school, of art and design, 113, 234
Bayard, Hippolyte, 128
Beck, Harry, 233, 235
Bézier handles
  controlling curves, 43
  creating curved paths, 154
  modifying paths, 165–167
  repositioning, 49–50
  tracing an image with Pen tool, 162–163
bitmap graphics
  digital photography and, 61
  pixels in, 10
  value/tonal range in, 91–92
bits, 4
black-and-white photo, applying color to, 125
Blank, Harrod, 65
blended images
  adding gradients and layer masks, 197–199
  adding vector mask, 192–193
  articulating the design challenge, 186
  combining vector shapes, 187–189
  creating basic button, 193–194
  creating layer groups, 195–196
  gradients, 184–185
  layer effects, 190–192
  networked technologies and, 180–182
  overview of, 179
  screen resolution, 183
  vector shapes, 183
blending modes, color, 120–121
blogjects, 180
boardstorming, at Jovenville, 293–296
Botanicalls project, 180–182
bracketing technique, 75–76
Brady, Mathew, 68, 80–81
branding, guidelines for design, 282–284
Braque, Georges, 133
Brautigan, Richard, 256
Breton, André, 131
Bringhurst, Robert, 238
brushes
  adding brushwork texture, 285
  adding details, 53–54
digital photography
Adobe Bridge and, 67, 80–81
Batch Rename tool for, 82–84
bracketing technique in, 75–76
camera mechanics for, 69–70
creating PDFs of images, 85–88
light measurement, 66
pixels, 61
preparatory considerations, 76–77
rule of thirds, 66–67, 77–79
as specialized craft, 65
zone system and, 93, 98–103
digital technologies
pointillism and, 3–4
qualities of, 2
Direct Selection tool
adding vector shapes, 227–229
making final adjustments, 229
modifying paths, 164–167
for modifying shapes, 49–50
Dobson, Kelly, 180
Doctorow, Cory, 180
documents
  copying layer to, 172–173
  creating with one artboard, 43–45
  sharing on web, 261
Dodge and Burn tools, 143–145
dots
  art and, 2–4
  computer graphics and, 2
  creating figure/ground, 15–17
  creating patterns, 7–8
  grouping/alignment of, 17–20
Doyle, Christopher, 280
drop shadows, 275–276
Duchamp, Marcel, 130, 133
E
ingestion, See also revision practices
color editing, 108
layer masks, 156
no editing vs. editing as every stage, 285
nondestructive, 156–158
Edwards, Mark, 155
effects
  drop shadows, 275–276
  layer effects, 190–192
Eggert, Alicia, 22, 23
Eisenstein, Sergei, 131
elements, working with on master pages, 266
Ellipse tool
  creating circles, 10, 195
  creating shapes, 13–14
  loading from Tools panel, 12
  enlarging images, 27–28
Eraser tool, 156
Essentials, setting workspace to, 27, 43, 77
Eternity clock, 22–23
ethics, of digital manipulation, 136–137
EV (exposure value), 75–76
Expand Appearance option, converting lines to shapes, 54
exporting, to PDFs, 276–277
exposure value (EV), 75–76
eyeball icon, making layers visible/invisible, 187
Eyedropper tool, adding Fill colors, 228
Ezer, Oded, 232
F
fair use, copyright law and, 132–133
faktura (Rodchenko), 129
Faludi, Rob, 181
families, typographic, 207
Felton, Nicholas, 256–257
files
  digital camera settings, 70
  naming/saving, 25
  renaming, 82–84
  utilizing master/shared, 36–38
fills/filling
  adding with Eyedropper tool, 228
  filling circle with color, 119
  filling rectangle with color, 275
  icons for, 14
Flaxton, Terry, 61–62
Fleming, Mike, 22, 23
fonts. See also typefaces
  creating typographic styles, 274
  personality of, 202
  selecting point size of type, 220
foreground, 7–8, 15–17
framing photographs, 69–70
Free Transform tool, 119, 174
f-stop values
  aperture size and, 66, 69, 72
  depth of field and, 73
G
Gestalt laws, 234, 236–237, 250, 255–258
Gestalt psychology, 7–8
Gilliam, Terry, 131
glyphs, 202
Gomez, Dr. L. Hernandez, 289
Good Gestalt, Gestalt laws, 236
gradients
  adding, 197–199
  applying to layer masks, 184–185
  Gradient tool, 33–34
grids
  guide placement, 242–243, 250–251
  historic uses of, 233–234
  using, 252
Grosz, George, 130
guides
  alignment and, 264–265
  establishing on master pages, 262–263, 266
  hiding/deleting, 52
  horizontal, 188
  placing on grid, 242–243, 250–251
  scaling and, 170
  snapping to, 269
Gutenberg, Johannes, 202–203
gutter, between text and images, 264
H
halation, 113, 118
Hand tool, 141–142
hardness setting brushes, 148
harmonies, color, 114–117
Hartman, Kate, 181
Heartfield, John, 130
Helvetica typeface, 206
highlights
  adjusting exposure value, 145
levels adjustment layer and, 105
histograms, 104–106, 109
History panel, Photoshop, 141
hoax creation, 137
Höch, Hannah, 130–131
hues
adding layer for, 177
adjusting, 116, 171
color correction, 122
HSL (hue, saturation, and luminosity), 107–108, 116–117
Hue/Saturation adjustment tool, 108
primary and complementary, 109–110
warm and cool hues, 113
Hughes, Jack, 112
human perception, 2, 21
hyphenation, 272–273

iconic graphics
adding/saving background color, 55–57
brushing details into treetop, 53–54
creating shape combinations, 46–47
creating shapes for, 43–45
logos as, 42
modifying shapes, 48–50
reflect/copy profile icon, 51–52
uniting shapes, 47–48
Illustrator. See Adobe Illustrator
image frames (InDesign), 270
Image Size dialog box, 95–98
images
adding gradient backgrounds, 33–34
creating borders, 31
creating depth in, 35–36
creating gutter between text and images, 264
duplicating, 31–32
importing, 266–269
measuring block for placing, 263–264
placing/locking, 27–29
placing/relinking, 217–218
prepping, 270
previewing, 268
relationship between type and, 206
replacing type with, 225–227
scaling, 276
utilizing master/shared files, 36–38
importing images, 266–269
Info panel, 103
iPad screen resolution, 183
ISO settings, for digital cameras, 71
Itten, Johannes, 39–40, 113
J
James, Christopher, 92
Johnson, Chris, 93
Johnson, D. Wayne, 280
Jordan, Chris, 8, 9
Jovenville, 293–296
JPG quality slider, 98
Jungmann, Ales, 22, 26
juxtaposition
in creating collages, 176
in Mark Edwards design, 155
photomontage and, 153
K
Kaiser, Kathleen, 281–283
kaleidolism.com, 41
Kane, John, 202, 204
kerning
adjusting horizontal space between letters, 213–215
adjusting letters to a guide, 251
display type, 220–225
for line spacing, 239
Key command, becoming efficient with, 245
Kodak’s Brownie camera, 59, 60
L
Lasso tool, 143
Lavers, Annette, 42
layer masks
Add Layer Mask button, 150–152
adding, 168, 197–199
applying gradients to, 184–185
converting, 167–170
fundamentals of working with, 156
scaling, 170–171
layers
clipping, 177
copying between documents, 172–173
creating background layer, 136, 140
creating for working on eyes, 144–146
creating for working on fingers, 148, 150–151
creating for working on forehead, 146–147
creating layer groups, 195–196
creating new, 148
effects, 190–192
flattening, 217
keeping copy of original, 140
moving, 225
naming, 148
rearranging stack order of, 145–146
Layers panel
Crop Preview in, 78, 79
gradients layer in, 33
rectangle path on top of, 55
selecting images within, 32
understanding, 29
LCD screen, for framing photographs, 69–70
Le, David, 74
leading
adjusting, 224
for letter spacing, 213–215, 239
placeholders for virtual, 244
The League of Imaginary Scientists, 289–292
legibility, of type, 205
Lehni, Juerg, 210–211
Lester, Paul Martin, 255–256
letters
kerning. See kerning
letterforms, 202
parts of, 203
levels adjustment layer, 103–106, 122
Library of Congress (LOC), 139, 159
light meters, for digital photography, 66
lines
  complexity of, 22
  creating with Pencil tool, 29–31
drawing intersecting, 31
leading for spacing, 239
length in typographic design, 237–238
qualities of, 4, 22–24
varying contrast to create depth, 35–36

linking
  Link button for image placement, 27
text boxes, 246–249

Lissitzky, El, 129–130
Load Path, 167
locking images, 28–29
logos, 42
London, Kati, 181
Lorem Ipsum, placeholder or dummy text, 246–247
Ludwig, Colleen, 22, 24
luminosity (lightness), 107–108, 116–117
Lupton, Ellen, 202–203, 234, 236

M
Macnab, Maggie, 22
Magic Wand, 173–176
Majoour, Martin, 204
Man, Ray, 128
Marks and Bleeds, 253
marqueeing shapes
circles, 16
ellipses, 13, 118
rectangles, 54
masks. See layer masks
master files, 36–37, 57
master pages
  accessing and applying, 259
  adding color and drop shadows, 275–276
  establishing guides on, 262–263, 266
McCarty, Kevin, 91–92
measuring blocks
  as guide, 250–251
  for image placement, 263–264
meetings, standing up at, 287
Meggs, Philip, 206, 212
Méliès, Georges, 131
Metadata Placard, in Adobe Bridge, 81
Miedinger, Max, 206
Miller, J. Abbott, 234
Minus Front button, 54
Moholy-Nagy, László, 128
montage, 129–131. See also collage
Move tool
  adjusting image position, 171
  centering content, 194
  moving layers, 225
  utilizing zone scale and, 99–101
Müller-Brockmann, Josef, 237
multipage layouts, 255–256, 259
multistability, 8
Museum of Contemporary Art (MOCA), 289–292
Myers, Tiffini, 113
MyShinyMonkey.com, 40–41

N
negative space
  creating virtual leading and, 244
  example of use of, 242
  in typographic design, 236
Negroponte, Nicholas, 1–2, 4–5
networked technologies, 180–182
New Document dialog box, 12, 43–44
New Filenames field, in Batch Rename tool, 82–84
Niépce, Nicéphore, 126–127
nondestructive editing, 156–158

O
opacity settings. See transparency/opacity settings
Option key, 15–16
Orozco, Joven, 293–296
orphans, typographic design and, 240–241
Outer Glow effect, layer effects, 190
Output workspace, 85–88
overflow text, text boxes and, 247–248

P
packaging, design of Hot Wheels packaging, 286–287
Pages panel
  adding color and drop shadows to master pages, 275–276
  creating master pages, 263
  navigating documents, 262
  placing images in documents, 266
Paintbrush tool, 53–54
paper, selecting size for printing, 242
paragraph styles
  applying, 277
  for consistent typographic treatment, 259
  creating, 271–274
paragraphs
  assembling type into, 237–241
  working with paragraph breaks, 249
Past Experience, Gestalt laws, 236
Path tool, 136
Path mode, vector tools, 187
Pathfinder panel
  Adobe Illustrator, 188
  for joining shapes, 48
  unwanted effects from, 53
paths
  converting to a selection and then to layer mask, 167–170
  creating curved, 154
  creating elliptical, 14
  making copies of, 15
  modifying, 164–167
  Pen tool creating, 160–164
Patrick, Bryan, 137
pattern brush, 17
PDFs
  creating PDF Portfolio, 208
  designing for reading on a screen, 259
  exporting, 276–277
  placing images in, 268
  saving multipage, 55–57
  sharing on web, 261
  of thumbnail-sized images, 85–88
  trim marks on, 253
Peirce, Charles Sanders, 42
Pen tool
modifying paths created with, 164–167
for precision selection, 154–155
tracing image contours, 160–164
vector-based tools in Photoshop, 187

Pencil tool
accessing Selection tool from, 31
choosing, 29–30
drawing lines with, 30–31

Pencilbox Studios, 281–285
petroglyph, 200

Pettis, Bre, 279–280

photograms, 91
photography
in color, 62
digital. See digital photography
history of, 59, 127
vector illustration vs., 60
zone system and, 61
photomontage, 129–131
Piana, Brian, 112
Picasso, Pablo, 133
pixels
applying pixel masks, 167
in bitmap graphics, 10
development of, 2
in digital photography, 61
Magic Wand tool and, 173–174
nondestructive editing and, 156
pixel-based layer masks, 184
redistributing, 90, 95–96
resampling, 90
UI designs and, 132
vector tools and, 187
placeholders, 244, 246–247
point sizes, of type, 219, 248
pointillism, 3–4
Polygonal Lasso tool, 114–115
Pragnanz, Law of, 234
previewing images, 268
previewing layout, 276
primary colors, 109, 110
printing
CMYK color and, 110
color modes and, 216
paper size for, 242
print resolution, 95–96
Profile menu, 11–12
Proximity, Gestalt laws, 236
PSD files, 268
public domain, 132, 173

R
Rectangle tool
adding shape for framing composition, 227–229
creating and positioning rectangular shapes, 263
creating borders, 31
filling rectangle with color, 275
using in Shape mode, 187
Rectangular Marquee tool, 114–115
Red Eye tool, 136
redistributing pixels, for resolution, 90, 95–96
Reflect tool, 51–52, 228–229
Rejlander, Oscar Gustav, 128
reparis and hoaxes
adding extra mummy finger with Clone Stamp tool, 147–149
creating hoaxes, 137
making tonal repairs with dodge and burn, 143–145
overview of, 136–137
reducing wrinkles with Spot Healing Brush, 146–147
removing dust and blemishes from photograph, 139–142
softening cloned edges, 150–152
source materials for, 138–139
Resample Image check box, 159–160
resampling pixels, 90, 96–98
resizing type, 220–225
resolution
DPI (dots per inch) settings, 159
redistributing pixels for, 90, 95–96
resampling pixels for, 96–98
screen resolution, 183
revision practices
boardstorming at Jovenille, 293–296
clarity and openness of communication and, 280–281
collaboration with institution scientists at MOCA, 289–292
overview of, 279
Pencilbox Studios Mission
Hospital project, 281–284
Pencilbox Studios Perception of the Princess project, 284–285
reworking package design at Mattel, 286
working with game time and real time in Elder Scroll IV:Oblivion, 287–289
RGB (red, green, black)
additive processes, 109–110
color modes and, 216
converting from gray scale to, 115
primary and complementary color and, 110–111
rhythm, in typographic design, 210–212
Rich, Alex, 210–211
Robinson, Henry Peach, 128
Rodchenko, Aleksandr, 129–130
Romain, Ron, 40–41
rotating
with Free Transform tool, 174
images, 172
text boxes, 223
Rounded Rectangle tool, 193–194
Rubin, Edgar, 8
Ruder, Emil, 202, 238
rule of thirds
cropping by, 122
in digital photography, 66–67
in postproduction editing, 77–79
rulers. See guides
RYB (red-yellow-blue) color model, 108

S
saccadic movement, of eyes, 237–238
Sagmeister, Stefan (and team), 212
sans serif typefaces, 205–206, 259
saturation
adding layer for, 177
adjusting, 171
HSL (hue, saturation, and luminosity), 107–108, 116–117
Hue/Saturation adjustment tool, 108
saving files, 25
scaling
collage, 170–171
images, 276–277
Non-Uniform Scale option, 244
Schad, Christian, 128
Schwitters, Kurt, 130
screen
color modes and, 216
designing typography for, 259
screen resolution, 96–98, 183
selection boxes, in zone scale analysis, 99–102
selections
adding text boxes, 218
adding to/deleting from, 144
choosing circle properties, 14
converting from a path and to a layer, 167–170
copying and pasting, 176–178
creating figure/ground, 20
dragging, 118
features of Selection tool, 13
Pen tool for precision selection, 154–155
sentences, 237–241
serif typefaces, 205–206
serifs, of a letter, 203
Seurat, Georges, 3–4
shadows
adding drop shadow to master pages, 275–276
levels adjustment layer and, 105
lightening, 144
Shape mode, vector tools, 187
shapes
creating rectangle with shape tools, 187–189
as iconic designs. See iconic graphics
as psychological tools, 39
tools for creating, 12–14, 44
Shift key, for constraining proportions, 14
shift-clicking circles, 17
shutter speed, 66, 69, 74
shutter speed priority, 66, 77
Signac, Paul, 3
Similarity, Gestalt laws, 236, 255–258
Simon, Scott, 280
simultaneous contrast, 113, 117–120
Sketchpad, 4
Smart Guides, for aligning shapes, 46–47
snapping, to guides, 269
Spiekermann, Erik, 202, 210, 280–281
spimes (Sterling), 180
Spot Healing Brush
digital repairs with, 136
reducing wrinkles, 146–147
removing dust and blemishes, 140–142
Sriskandaraja, Sai, 181
stacking order, in Illustrator, 45
Stark, Kio, 279–280
Sterling, Bruce, 180
strokes
changing value of, 30, 36, 53
creating basic button, 193–194
Ellipse tool options for, 12
filling rectangle with color and, 275
icons for, 14
styles, creating typographic, 271–274
subtractive processes, color, 108
surrealism, 131, 176
Sutherland, Ivan, 4
Swiss international style, 236–237
Symmetry, Gestalt laws, 236
T
Talbot, William Henry Fox, 127–128
Template button, 27
templates, master pages as, 259
Terror, Diogo, 237
text
changing color of, 249
creating gutter between text and images, 264
creating typographic styles, 274
leading, kerning, and tracking, 213–215
placeholder or dummy text (Lorem Ipsum), 246–247
placing in text frames, 270–271
text boxes
adding, 218–219
creating, 252
linking, 246–249
rotating, 223
Type tool and, 213
text frames (InDesign)
for cover page, 277
modifying or aligning content in, 274
placing text in, 270–271
repositioning, 276
texture, adding brushwork texture, 285
Thinking with Type (Lupton), 236
Thompson, Bill, 281, 284–285
Thompson, Lauren, 73
Thomson, Jon, 63–64
TIFF images, 159
Tingley, Ashley, 74
tonal range
modifying, 103–106
in photographic images, 91–92
Tool Tips, 17–18
Tools panel
loading tools from, 12
“tear off” arrow on, 48
“tear off” arrow on, 48
tracking (letter spacing), 213–215, 273
transformations
centering content and, 194
with Free Transform tool, 174
rotating images, 172
scaling images, 170–171
transparency/opacity settings
adding color and drop shadows to master page, 275
brush values, 148
filling circle with color and, 119
locking, 120
for type, 223
trim marks, on PDFs, 253
Tschichold, Jan, 237
Turkle, Sherry, 180
tweetjects, 180
Type tool
adding text boxes, 218–219
adjusting kerning, tracking and leading, 213–215
changing point size of type, 248
creating text boxes, 247
resizing and kerning type, 220–225
selecting typeface, 194
vector-based tools in Photoshop, 187
ways of using, 213
typefaces
designing PDFs for reading on a screen, 259
families of, 207
selecting, 218
serif vs. sans serif, 205–206
typography
adding text boxes, 218–219
adding vector shapes for framing composition, 227–229
classifications of type, 204–205
color modes in, 216
contrast and rhythm in designing, 210–212
designing for screen, 259
final adjustments, 229–232
grid for aligning composition, 233
Illustrator vs. InDesign, 208
kerning, 213–215, 220–225, 239
leading, 213–215, 239
letter parts, 203
letterforms, 202
negative space in design, 236
overview of, 201–202
placing/relinking images, 217–218
relationship between type and images, 206
replacing type with an image, 225–227
resizing type, 220–225
sentences and paragraphs, 237–241
serif vs. sans serif typefaces, 205–206
styles, 271–274
Swiss international style, 236–237
text boxes, 213
typeface families, 207
widows and orphans, 240–241
Tzara, Tristan, 129
U
UI (user interface), 132, 183
Unite button, combining multiple shapes, 52
V
values, in photographic images, 91–92
Van Deusen, Thomas, 71
vector graphics
anchor points in, 10
in app user interface, 183
Bézier handles and, 43
developing with vector shape tools, 183
photography vs., 60
vector masks, 167, 192–193
vector shapes
combining, 187–189
designing vector graphics, 183
framing composition with, 227–229
UI designs and, 132
vector-based layer masks, 184–185
vector-based tools in Photoshop, 187
verisimilitude, 134
Vertical Align Top button, 17
viewfinder, for framing photographs, 69–70
Villareal, Leo, xiv, 3, 8
virtual environments, 180
visual images
dots in, 3
pixels for, 2
W
Walsh, Jessica, 212
Warhol, Andy, 133
warm hues, 113
Web, sharing documents on, 261
white balance settings, for digital cameras, 72
white space, adjusting kerning and, 214
Widener, Jeff, 137
widows, typographic design and, 240–241
Willow, Simon, 133
workspace(s)
Adobe Bridge, 80–81, 85–88
setting up, 27, 158–160
X
x-height, of a letter, 203
Z
Zellen, Jody, 258
zone system
analyzing photographs with, 98–103
for digital cameras, 93
overview of, 61
Zoom tool, 141–142
Unlimited online access to all Peachpit, Adobe Press, Apple Training, and New Riders videos and books, as well as content from other leading publishers including: O’Reilly Media, Focal Press, Sams, Que, Total Training, John Wiley & Sons, Course Technology PTR, Class on Demand, VTC, and more.

No time commitment or contract required! Sign up for one month or a year. All for $19.99 a month

SIGN UP TODAY
peachpit.com/creativeedge
This page intentionally left blank
FIGURE S5.1 Josh Emerson, *Responsive Dog* website. Resize your browser to see the dog “respond” to your browser’s dimensions.